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This manual provides an overview of PPM and, using examples, introduces you to basic
functionalities.

The quick start guide to process analysis is intended for PPM users being process owners or
business analysts.

Role definition

As a process owner, you can

= call predefined queries.

= interpret the resultsin reports.

As a business analyst, you can

= create basic analyses by using measures, dimensions, filters, and various views.
= perform cause analyses for your processes and organizations.

Tip

More information on PPM is available in the PPM user interface under PPM > Documentation.
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2 PPM demo database

PPM includes a demo database that you can use to familiarize yourself with the program.

If you want to work with an example we recommend that you use the umg_en demo
database. The demo database contains all measures and dimensions that you need for the
examples. It is possible that the measures and dimensions in the use cases are not available
due to the configuration of your company-specific PPM database. Of course, you can use any
other process types, measures, and dimensions to work with the example.

You can use PPM Customizing Toolkit to install the demo database. If you want to use the
demo database, please contact your system administrator.



PROCESS ANALYSIS QUICK START GUIDE

ARIS Process Performance Manager (PPM) provides comprehensive analysis functions (Slice
& Dice, ad-hoc analyses, reporting, etc.) to monitor and evaluate the performance of business
units and business processes from various perspectives (for example, results view vs. view of
processes leading to results). By combining business process data, social interaction
patterns, and result data users can create integrated analyses for measure evaluation. These
analyses allow comprehensive insight into daily routines and results of a company and thus
represent the basis for benchmarking and weak point analyses - for example, early
identification and resolving of bottlenecks or problematic interaction patterns.

Business processes (page 7) are operational business activities. Effective company
management therefore requires active business process controlling (Business Process
Intelligence (page 7)). Process performance management continuously monitors planned
goals and warns in time if deviations from the plan occur so that suitable countermeasures
can be initiated. This is how companies achieve improved process quality, which directly
impacts business performance. The continuous monitoring of actual business processes
therefore closes the gap between corporate strategy and its operational implementation.

PPM supports you in analyzing your processes by providing comprehensive online analysis
options based on measures and by representing your actual, measured processes. For an
efficient process analysis, PPM gathers the necessary data from your operational systems,
automatically reconstructs the processes across the whole system, and calculates the
measures required for these processes. The individual process instances (page 8), that is,
actual processes or transactions (for example, an order #4711 received by FAX on
17-Sep-2005) are imported from a freely definable source system (such as SAP MM) and
represented in an EPC (page 7) (event-driven process chain). For data extraction from your
source systems, PPM provides all required interfaces and extractors.

Process analysis mainly involves specifying process and function measures (cycle times,
frequencies, costs, adherence to deadlines and quality guidelines), as well as representing the
actual process in an EPC view. The visualization functions have been developed in such a way
as to make a process view more informative and easy to read. PPM provides a wide selection
of chart types and tables for you to display the results of your analyses clearly and in detail.

Example

The following illustrations show examples of a process analysis of the cross series processes
of the Order processing.
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The first example shows a trend chart with the process cycle time for the year 2008. It
illustrates the development of the process cycle time in the course of the year and how the
actual measure behaves in relation to the planned values.

Example: Trend chart of process cycle time
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The following example shows a process instance in the form of an EPC, which PPM
automatically generated based on the measured processes. It illustrates the actual flow of an
individual process of the cross series process type (page 8) in the Order processing process

type group.
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Example: Display process instance as EPC

Process bype group: Order processing
Process bype: cross series
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Creake contract ‘ Dealer sales
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130209 18:13:42 Tearnl

Car deliverad
to distribution
centar

The following example illustrates the data measured by PPM for the selected process
instance. The data of the process instance or the individual process elements, such as
functions or events are displayed as attributes.
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Example: Process instance attributes
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Tip

The PPM user interface provides you with all of the functions required to set your analyses

and display the results.
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Process intelligence (Business Process Intelligence) describes a method for systematic
analysis (collection, evaluation, representation) of business processes and company data
(process data) in electronic form. The objective is to obtain conclusions that enable improved
operative or strategic decision-making in terms of corporate goals. Process intelligence
provides an objective basis for decisions pertaining to displaying and implementing
improvement potential in real time. Automated analyses identify factors that affect process
performance.

A business process is a sequence of activities aiming to achieve business results. A business
process is usually run through multiple times, can be part of another business process or
contain or trigger other business processes. Business processes often apply across
departments and divisions and are therefore part of the company organization structure.

An event-driven process chain is a model type used to graphically describe the chronological
sequence of a performance delivery process. The event-driven process chain is based on the
following assumptions:

= Each activity within a process is triggered by a commercially relevant change of state of
an information object.

= Each activity can result in a commercially relevant change of state of an information
object.

The status of a commercially relevant information object is graphically described by means of
an event. Functions are used for the graphic representation of activities.

Linking events and functions in series and connecting these objects with directed
connections graphically represents the control flow of the process. Since an event can trigger
several functions and since a function can have several events, the process path can branch.
AND, OR, or EXCLUSIVE OR rules are inserted at branches of the process path. They illustrate
the logical relationship that exists between the sequenced objects.

Organizational units can be assigned to a function. An organizational unit describes the group
of processors in the company which executes the function in question. Organizational units
are linked to the relevant function using connections.

EPCs are used in PPM to represent processes actually executed in the past (so-called process
instances).
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Concrete occurrence of a process, for example, processing of standard order 4711. A process
instance describes the sequence of activities performed in the company to deliver a required
product or service.

Process instances provide the data base for calculation of the measures in PPM. They are
provided by a data import from a source system.

In PPM, the EPC (page 7) model type is used for the graphic representation of process
instances.

All process instances are classified when you import data into PPM. They are therefore
assigned to process types. This assignment ensures that order processing transactions are
not compared against return transactions, for example.

In business, measures represent aggregated information on quantifiable operating facts.
They are intended to enable easy control of processes and results.

Example

An example of a measure is the process duration (or process cycle time). It is calculated based
on two process instance measurement points, Start time and End time. The
calculation/measurement is performed for each process instance. When analyzing multiple
process instances, the measurement values of the individual instances are aggregated (for
example, by averaging) and the aggregated values are then displayed in PPM. Measures are
sometimes referred to as metrics, as well.

Measure evaluation

The rating of a measure indicates the effects of an increasing measure value on the

achievement of your process goals.

= Positive means that rising values have a positive effect on goal accomplishment (for
example, number of orders).

= Negative means that rising values have a negative effect on goal accomplishment (for
example, process cycle time).
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Dimensions are criteria according to which the measures analyzed can be differentiated (for
example, sales organization or order volume).

Dimensions can be configured in terms of step width and value range. For example, the Time
dimension can be displayed with the step widths Year, Quarter, Month, Week, Day, or Hour.
The incremental calculation or analysis of a measure via a dimension is also called iteration.
You can restrict the value range using filters. For the Time dimension, the value range can be
defined as a period (for example, time from 07/01/01to 07/01/02).

Filters limit the number of process instances to be included in the aggregation of a measure
during analysis. You can define filters for measures and dimensions. Each filter describes a
specific value range for a measure or dimension, and process instances falling within this
range will be included in the analysis.

A planned value describes the objective for individual process measures that you can specify
in a planned value definition. A planned value definition consists of two numerical values.

Planned value 1is the value above or below which the measure moves into a critical range.
As soon as the measure infringes this planned value (green-yellow limit), accomplishment of
the process goal is jeopardized and you should initiate improvement measures immediately.
Planned value 2 (yellow-red limit) corresponds to the planned measure value. As soon as the
measure infringes this planned value, the goal has not been accomplished.

Queries summarize the configuration of analyses, for example, filters, dimensions, measures
and view type.

You can use the PPM user interface to interactively set up and run a query and display the
analysis results.

A favorite is a shortcut to quickly access a query that already exists. Using favorites, you can,
for example, create frequently used queries and reuse them.
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A favorite does not store the actual values of a query, but the following criteria:

Process types or functions
Measures

Dimensions

Filter

View

Formatting of the individual views

10
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This chapter describes how to start the PPM user interface.

To use PPM, you must log in as a user to an available PPM client. Depending on how PPM was
installed, you call up the user interface via a Web browser or start it as a local installation.

Before you can start the userinterface you need to start the required infrastructure
components and PPM components.

In PPM, the system user is created with the password manager by default. You log in with
this user/password combination if the password has not been changed and if you have not
been configured as a PPM user.

Tip

For further information on PPM installation, please refer to the document PPM Installation or
contact your system administrator.

Procedure

1. Openthe Windows Start menu and click Start ARIS PPM Core 10.5.3 in the ARIS > PPM
10.5.3 > Start Servers program group.

The infrastructure components and PPM components start. As soon as the start process
is completed, you can start the PPM user interface.

2. Openthe Windows Start menu and click ARIS PPM GUI 10.5.3 in the ARIS > PPM 10.5.3 >
Tools program group.

The login dialog is displayed.

Enter system in the User box.

In the Password box, enter the password manager.

In the Client box, enter the client name umg_en.

Click Next.

In the Language box, select the language that PPMis to be displayed in.

® N o o A W

Enable the option Save login data if you want to save the login data entered for the next
login. The password will not be saved.

9. ClickLogin.
The PPM user interface is started and the start page is displayed.

The PPM start page provides quick and easy access to your analyses. (page 38)

"
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This chapter uses a complete use case example to describe basic PPM functionalities.
For your process analysis, the following questions must be considered.

= Whatis the goal of your analysis (for example, do you want to find out about the causes
of a planned value deviation or conduct a performance analysis of particular processes)?

= Which processes in your company do you want to analyze, for example, sales or order
processing?

=  Which measures (for example, sales or process cycle time) do you want to view for which
dimensions (for example, sales or sales organization)?

= Whatis the best view type (for example, chart or table) for the results of your analyses?

Example
Situation

Several customers complained about very long processing times of their orders and that
deadlines were not met. You should therefore find possible weak spots in your company
processes.

Procedure

You want to examine the Order processing processes, in particular the cross series
processes with a view to planned value deviations and suspected deviations pertaining to
Process cycle time.

First, you query the process performance of the cross series in order processing. Then you
perform your analysis in detail for your company's Dealers for the year 2009. In addition, you
evaluate the analysis results by quarter. Using the process instance analysis, you examine the
suspected deviations in your processes. You display your analyses in various views in
structured charts and tables and make them available as a PDF document.

Your procedure consists of the following steps:

= Display a predefined query

= Createa 2D and 3D column chart

= Createlist table

= Determine process instance distribution

= Display anomalous process instances as an EPC
=  Perform EPC benchmark

=  Qutput analyses as a PDF document

12
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6.1 Display favorites

You want to display suspected deviations in the processes of the SUV series area. This is an
analysis that you will frequently use to find out in time about possible anomalies in your
processes.

A predefined query (page 9) is available as a favorite (page 9) to do this. With this favorite, you
can easily run frequently used queries (Queries bar).

Procedure

1. Select the Process analysis module.

2. Click Private favorites in the Favorites bar.

3. Double-click the 01 Process cycle time favorite.

A speedometer chart displays the current average process cycle time relative to the
defined planned values. With 83 days, the process cycle time is in the critical range and
deviates from the defined planned value 2 (yellow/red limit).

Example: Process performance in the SUV series area
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Process cycle time [Days]

60 100

13
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You want to save your current analysis results to be able to reuse them later.

To do so, you can copy your analysis to the Clipboard panel. The Clipboard panel keeps your
analysis for the duration of your current PPM session.

Procedure

1. Display the Clipboard tab bar.

2. Click the Apply button.

Your current analysis is saved in the Clipboard panel and displayed as a thumbnail.

Tip

If you want to reuse your analysis in a subsequent PPM session you can save it as a favorite.

For detailed information on this topic, please refer to the PPM help topics.

You want to analyze the process performance of the cross series processes in detail for the
year 2009, and you suspect weak spots at your dealers. Your analysis is to be displayed in a
clear and easy-to-read chart.

The analysis of only one measure (page 8) (Process cycle time) and one dimension (page 9)
(Dealer) can easily be displayed in a 2D column chart.

Use a wizard to create your analysis.

In the wizard, set the following items for your analysis.
= View type: 2D column chart

= Processes: SUV series of Order processing

= Measure: Process cycle time

= Dimension: Dealer

= Filter: 2009

Procedure

1. Display the Base tab bar.

Click B New.

Click the Two-dimensional chart button.
Click Execute.

Click the Column chart button.

Click Next.

N o ok

Double-click the Order processing process type group in the process tree.

14
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8. Select the cross series process type.

Only the process instances of this process type will be evaluated.
9. Click Next.
10. Select the Process cycle time measure.

The process cycle times of the process instances you selected in the previous step are
analyzed.

11. Click Next.
12. Select the Dealer dimension.
The process cycle times of the standard orders are analyzed for the selected dealers.
13. Click Next.
14. Double-click the Time dimension.
a. Enter 2009 on the Absolute tab.
b. Click OK.
Only data for the year 2009 will be analyzed.
15. Click Finish.

Your process analysis is displayed as a 2D column chart.

15
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Example: Process cycle time/Dealer process analysis as a 2D column chart

1100
1050
1000
950
200
B5.0
&0

=

75

=

70

=

635

=

&0

=

55

=

50

=

45

=

Process cycle time [Days]

40

=

35

=

30

=

25

=

20

=

15

=

10

=

5

=

Germany-Hamburg USA-Dallas LSA-Philadelphia USA-Seattle
Germany-Frankfurt Germany-Munich USA-Denver UsA.-5an Framcisco

Dealer [Detailed]

0.0

6.4 Display measure values and legend in the chart

You want to display the measure values for each dealer in your chart and also want to show a

legend.

Procedure

1.

O A R

Display the Base tab bar.

Click £ Display options.

Display the Chart settings page.

Select the Absolute option in the Measure values group box.
Display the Labels page.

Enable the Display legend option.

Display the Colors page.

16
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8. Enable the Highlight values option in the Display effects group box.
Now the measure values and a legend are displayed in your chart.
Tip

You can move the displayed legend in the chart using the mouse.

6.5 Display planned values

You want to display planned values (page 9) in your chart to see which of your dealers meet
or deviate from the planned values.

Additionally, you display the planned values and measure areas in your current analysis.
Procedure

1. Display the Query tab bar.

2. Click ¢ Planned values.

The planned values and the corresponding measure areas are displayed in color in your chart.

Planned value 1 indicates the borderline between the uncritical area (green) and the
unfavorable area (yellow), while Planned value 2 demarcates the borderline to the critical
area (red).

17
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Example: Display planned values in process analysis
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6.6 Set filter

You want to limit your process analysis to the two dealers with the longest process cycle time
and compare them to the dealer with the shortest process cycle time.

To do so, set a filter (page 9) for your dealers that returns the dimension steps with the
relevant measure values. The filter includes the dealers in Frankfurt and San Francisco, both
of which are close to planned value 2, and Munich with the shortest process cycle time.

Procedure

1.

o N

Enable the Filters bar.

Display the Filters tab bar.

Click Y Select criteria.

Double-click Dealer in the Available dimensions/measures column.
Click OK.

The filter criterion Dealer is added to the Filters bar.

18
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6. Click * Expand in front of the Germany and USA filter values under the filter criterion
Dealer.
The tree expands accordingly.

7. Enable the filter values Frankfurt, Munich, and San Francisco.

The column chart displays only the columns for Frankfurt, Munich, and San Francisco.
8. Set the sort direction for the chart axis.

a. Inyour chart, right-click the Dealer dimension.

b. Select Sort axis values.

c. Select Ascending as direction and Process cycle time as sort criterion.
d. Click OK.

The set filter is applied to your analysis and the dimension steps are displayed in your chart in
line with their measure values in ascending order.

Example: Process analysis with filter
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6.7 Replace dimension

Next, you want to analyze the process cycle times for the SUV series area for the year 2009.

To do this, you can replace the Dealer dimension with the Time dimension directly in your
chart.

REPLACE DIMENSION

Procedure

1. Inyour chart, right-click the Dealer dimension and select Replace dimension.

2. Select the Time dimension.

3. Click OK.

The new Time dimension and the Process cycle time measure with the corresponding
planned values are displayed in your chart.

Tip

Alternatively, you can replace a dimension by drag and drop. To do this, display the

Dimensions bar and drag the relevant dimension with the mouse to the desired position in
your chart.

You can also replace measures in your analysis using the same procedure.

6.8 Set step width

You want to summarize the display of the set Time dimension in quarters instead of
displaying it in months.

To do so, set the step width of the Time dimension.

Procedure

SET STEP WIDTH

1. Display the Settings bar.

2. Forthe Time dimension, click the currently set step width.
3. Enable the By quarter option.

4. Click OK.

The set step width is applied to your analysis and displayed as a single column in your chart.

20



PROCESS ANALYSIS QUICK START GUIDE

Example: By quarter step width of the Time dimension
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6.9 Add dimension

You want to display the two individually analyzed dimensions in one chart to determine
possible interrelations.

To do so, add the Dealer dimension of your current analysis to the Time dimension and hide
the planned values from your chart for better reading.

Procedure

=

Display the Query tab bar.

Click & select dimensions.
Double-click the Dealer dimension.
Click OK.

o DN

Click ¢ Hide planned values in the Query tab bar.

21
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The additional dimension is added to your analysis and displayed in your chart. The individual

sales organizations are grouped for each quarter in line with the set step width.

In the fourth quarter of 2009, the process cycle times of the three dealers are almost
identical.

Example: Process analysis with the Sales organization and Time dimensions
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6.10 Change analysis view

To obtain a better overview, you want to display each dimension of your analysis on its own
chart axis. Besides, you want to summarize your analysis in a table and display the planned
values.

22
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To do this, select the corresponding analysis view. To display the analysis of two dimensions
and a measure, you can select a 3D column chart, for example. To display planned values in a
table, a list table is recommended for an analysis view.

Procedure

=

Display the Visualization tab bar.

2. Click Wi Select analysis view.

3. Double-click the 3D column chart button.

4. Setdescending sort direction for the Dealer axis.
(See chapter Set filter (page 18))

5. Torender the chart clearer, set the color of the columns for the dealer in Frankfurt.
a.
b.
C.
d.

Right-click a column of the Frankfurt dealer.
Click Edit color assignment in the pop-up menu.
Select a color.

Click OK.

The changed settings are applied to your current analysis.
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Example: Analysis of a measure and two dimensions in a 3D column chart

Process cycle time [Days]

1150

1100 W USA-San Francsos

Germarny-Frankfurt
W Germary-Munich

1050

1000
45.0
20.0
&30
20.0
750
700
65.0
E0.0
550

45.0
400
350
30.0
250
200
1540
10,0

Dealer

USA-San Francisco
Germany-Frankfurt
Germany-Munich

0

e Q1,10 Q10 Q310 Q4,10

Time [By quarter]

DISPLAY LIST TABLE

Procedure

1.

o DN

Display the Visualization tab bar.
Click HH Display list table.
Display the Query tab bar.

Click ¢ Show planned values.

In the table, click the header of the column Process cycle time to sort the table in
descending (¥) or ascending (1) order.

The changed settings are applied to your current analysis.

The list table is sorted by process cycle time including planned values 1and 2. The measure

values are colored in line with your goal accomplishment.
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Example: Analysis of a measure and two dimensions with planned values as a list table

Table
Time [By quarter]
Q110
QL 10
Q1,10
Q210
Q210
Q210
Q310
Q310
Q310
Q4,10
Q4,10
Q4,10

6.1

Dealer [Detailed]

Germany-Frankat
Germany-bunich
US&-2an Francisce
Germany-Franidurt
ﬁgrman:r--!-.lunn;ll
Uss-San Francisco
Germany-Frankfuart
Germany-bunich
USa-Sen Francisce
Germany-Franidiar
Germany-Munich

USa-San Francisce

Display process instance distribution

Frocess cycle time: [Days)

844
758
1013
44
753

132
2
8.0
613
610
613

Flanned valse 2 Process cyche time [Days]

Flanned value 1 Process cycle time [Days]

00
0.0
00
0.0
mna
0.0
.0
0.0
.0
0.0
0.0
0.0

You want to know how process instances distribute to the various process cycle times or, in

other words, you want to see with which process cycle times the most processes are
executed inthe SUV series area.

To do so, create a distribution chart for your analysis. A distribution chart displays the number

of process instances for a distributable measure.

You can create a distribution chart either using a wizard or, if your current analysis already

contains the relevant measure, using 2= Show distribution.

Procedure

1. Display the Query tab bar.

2. Click 1= Show distribution.
3. Display the Clipboard tab bar.
4. Click the Apply button.

A distribution chart is displayed for the set Process cycle time measure and your query is

saved in the Clipboard panel.

Most process instances are in the uncritical area (green), but are very close to the average

value.
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Example: Distribution chart of the Process cycle time measure

Murmber of processes

6.

- Average vl

T

650 i

- RN I

B {11000

B {5 v

B EEREREN

400

350

B I

250 |

N I

150 |

B I

' l iﬂil==l=
a _35.1} -ISuﬂ 54.0 &3.0' 720 . &1.1] S0.0.-53.0 <1170 1260 -1350 1440-153.0 162.0-171.0 180.0-15390 1980 .2070
270 - 360 45.0 - 4.0 630 -72.0 31.0 - 900 9.0 - I{B.ﬂ 117.0 -126.0 13501440 153.0.1620 17101800 1890 -15%3.0

Process cycle time [Days]
12 Display process instances

You want to view the process instances in the critical area in detail. The data range of interest
comprises the process cycle times 81to 180 days, which are above the defined planned

value.

Display a list of the critical process instances for the corresponding data range.

Procedure

1. Display the Visualization tab bar.

2. Click :-! Select data range.

3. With the mouse, drag a selection frame in the chart around the columns of the data range
81.0-90.0 to 171.0-180.0 days.
The area is now selected.

4. Inthe selected area, click * Display menu.
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5. Click Display process instance table in the pop-up menu.

The process instance table with the critical process instances of the selected area is
displayed.

6. Click the header of the column Process cycle time to sort the table by process cycle
time in descending order.

7. From the list, select the process instance with the longest process cycle time.

The EPC pertaining to the selected process instance is displayed.

Example: Process instance and EPC with the longest process cycle time

Order processing-cross series

Process identification ¥ Process cycle time [Days] | Number of processes EPC Attnbutes Functions Flow chart Resources
UMG=0000000080-3_54645817 1530 ) 1y -
UMG=0000000080-3_436247... 1529 1 PROCAEE Wy o T Fo kg
UMG=0000000080-3_436247... 1526 1 ProONS Hyoe: Crom st
UMG=0000000080-3_436247.... 1523 1
UMG*0000000080-3_436247... 1513 1
UMG=0000000080-3_436247... 1510 1
UMG=0000000030-3 _436247.... 1501 1

0L,02/10 12:30:2% Tewrd
UMG®0000000080-3_54646640 1500 1
UMG=0000000080-3_5684925 1499 1

Craste contract ‘

UMG=0000000080-3_436247.... 1494 1
UMG=0000000080-3_436247..., 1489 1 14/02/10 16100134 I Teard
UMG=0000000080-3_436247.... 1456 1
UMG=0000000050-3_54646609 1477 1 B
UMG=0000000050-3_54646254 1463 1

1502410 12:08:53 Teaerd
UMG=0000000080-3_54646443 1462 1
UMG#0000000080-3_54646052 1461 1
UMG=0000000030-3_54646225 1447 1
UMG=0000000050-3_436247.... 1442 1 2130 5:27:59 Tewn)
UMG=0000000080-3_436247... 1440 1 R
UMG20000000080-3_436247.. 1438 1 Plfaaooe | oo
UMG=0000000080-3 436247.... 1436 1

02/04/10 23158159 Teard
UMG=0000000080-3_436247... 1430 1
UMG=0000000050-3_5684965 1429 1 Chacve Sales

cushomar order ‘ support

UMG®0000000080-3_5685017 1425 1 Yovn
UMG=0000000050-3_5685015 1415 1 1405110 14:51:26 | Tearrd
UMG=0000000030-3_54646528 411 1
UMG20000000080-3_436247... 1410 1 Create debvery e
LIRS GAAAADAANEN S ANEY AR LY ‘ Y. 4t
‘ » ‘ » |

6.13 Compare processes

You want to compare process instances with long and short process cycle times to identify
possible weak spots in the process.
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To do so, compare the two aggregated EPCs of the respective process instances. An

aggregated process creates an aggregated process from multiple process instances and

assigns a probability of execution to each path in the process.

Use the Clipboard panel to compare two EPCs.

Tip

To improve the process display, you can hide organizational units and events in the displayed

EPC. Only functions and start and end events of the EPC are displayed now.

Procedure

1. Click in the process instance table and select all process instances by pressing Ctrl and

A.

All process instances in the table are selected and an aggregated EPC of all selected

process instances is displayed.

2. Display the Base tab bar.
3. Click B Display options.
4. Display the EPC view settings page.
5. Disable the Organizational units and Events options in the Display box.
6. Click OK.
Organizational units and events are no longer displayed.
7. Display the Visualization tab bar.

8. Click [£3l Fit to window.

The complete EPC is displayed in the window.
9. Display the Clipboard tab bar.
10. Click the Apply button.

Your current query is saved in the Clipboard panel.

Procedure

1. Inthe Clipboard panel, double-click the previously created distribution chart.
The distribution chart is displayed.

2. Inthe chart, right-click the bar with the shortest process cycle time.

3. Select Display process instance table.
The table of process instances with the shortest process cycle time is displayed.

4. Click inthe table and select all process instances by pressing Ctrl and A.

All process instances in the table are selected and an aggregated EPC of all selected

process instances is displayed.
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5. Display the Base tab bar.
6. Click E& Display options.
7. Display the EPC view settings page.
8. Disable the Organizational units and Events options in the Display box.
9. Click OK.
10. Organizational units and events are no longer displayed.
1. Display the Visualization tab bar.
12. Click EZ Fit to window.
The complete EPC is displayed in the window.
13. Display the Clipboard tab bar.
14. Click the Apply button.

Your current query is saved in the Clipboard panel.

Procedure

1. Select both queries in the Clipboard panel.

2. Inthe Clipboard tab bar, click the Benchmark button.

Both processes are displayed in one window side by side in their EPC views.

You can now compare both processes in detail and examine them for process weak spots.
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Example: EPC benchmark on process cycle time
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6.14 Process variants

With version 10.1 PPM provides the process variants feature with the new Variants bar as
additional analysis tool.

6.14.1 Variants bar

Use the Variants bar to get an overview of the most typical process variants, to identify
irregular processes, and to analyze them for, for example, critical outliers. Accordingly, you
can select variants for filtering your current analysis.

The Variants bar contains all process variants of your analysis, taking your current filter
settings into account. It shows how often certain process variants occur in your analysis and
shows their frequency graphically and numerically. You can set the scaling of the variant
values (linear or logarithmic) to adjust the bars displayed (context menu (¥) -> Preferences).

The variants are listed descending by their frequency on one or more pages of the Variant
bar. The number of variants displayed per page can be set (context menu (¥) -> Preferences).

The variants listed depend on the variant dimension level selected. Variant has two
dimension levels, Combined variant (rough step width) and Precise variant (refined step
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width), and the Name as dimension value. The Combined variant level is set initially. The
dimension level can be changed in the context menu ().

Examples
Combined variant with rough step width: v1, v2, v3,...
Precise variant with refined step width: v1-1, v1-2, v1-3..... ,v2-1,v2-2, v2-3... v3-1,v3-2,

Similar to other dimensions, you can set a filter for the Variant dimension. (See Introduction
to filters for details.) The filtered variant dimension values are highlighted graphically. But
only the filtered variants of the selected dimension level are displayed.

Example

The filter set for the variant dimension contains the following values: v1; v4; v6-3; v12-1. If th
Combined variant level is selected only the values v1 and v4 are displayed. If you switch to
the Precise variant level the values v6-3 and v12-1 are displayed.

The variant vO(n/a) shows the number of all variants without values assigned (values are
"not maintained"). The variant vO(n/a) is always displayed at the end of the dimension value
list.

The "Others"-entry informs you how many other variants exist besides those listed and (in
brackets) how many process instances are covered by these other variants. If the number of
dimension values exceeds this maximum of displayed values (Default is 5000) an
"Others"-entry is added at the end of the variants list. The entry is not selectable.

The Variants bar is only available if the Variant dimension is configured in PPM.

e
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Example: Variants bar with six precise variant values selected for filtering

Variants x
Precise variant =
ve-1 [ oz
vi-1 [ 8,776
v2-1 [ 3,743
vas-1 [ 3,021
271 1,818
ve-1 [ 1,801
1,208
vze-1 [ 1,023
-1 Vanant; v29-1 7
Value: 1,023 715
428
0 422
3 47
a5 25
40 252
28 44
7-2 35
4 o2
32- 7
7 -
1 100 10,000
G of 73 variants selected
112 3 »

6.14.2 Use variants

You can use the Variants bar to identify the most frequently executed processes and critical
outlier.

The following example based on a function flow diagram shows how you can use the
Variants bar for your analyses. You can use the function flow diagram to analyze the
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sequence of activities within your business processes. This view enables you to clearly
display and evaluate the process structure and the relationship between the activities.

Procedure

1. Open the Interaction analysis realm.
Display the Base tab bar.

Click B New.

Double click the Function flow button.

a DN

Specify your settings and click Finish. Select Order processing as process instances and
Function cycle time (relation) as measure.

The function flow diagram is displayed.
6. Clickthe ' variants button if the Variants bar is not already displayed.
The Variants bar is displayed with all process variants of the current analysis.
Example

Initially all existing variants of the created function flow are preselected in the Variants bar.
The function flow displayed is the aggregated function flow across all variants.

33



PROCESS ANALYSIS QUICK START GUIDE
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COMPARE PROCESS VARIANTS

Filtering one or more variants in the Variants bar enables you to compare and analyze
individual process variants. The comparison of several process variants helps you to identify
weaknesses and problems in your business processes.

Process variant v1 is the most frequently executed process variant and therefore probably
the planned target process. You can display the v1 variant of the function flow and compare it
with other process variants by using the Clipboard panel.

Procedure

1. Clickthe B Clipboard button to display the Clipboard panel and Clipboard tab.
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7.

Click the v1 variant in the Variant bar. The filtered v1 variant of the function flow is
displayed.

Activate the Clipboard tab and click the B Add button. The filtered function flow is
added to the clipboard.

Click again the v1 variant in the Variant bar to cancel the selection.

Click the v5 variant in the Variant bar. The filtered v5 variant of the function flow is
displayed.
Click the Add button in the Clipboard tab. The filtered function flow is added to the
clipboard.

Click the #ll Benchmark button in the Clipboard tab.

Both variants are displayed in a separate window.
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Example

The direct comparison shows a significant deviation of variant v5 (on the right-hand side) to
variant v1 (the planed target process).

SE3TE6S
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Based on the variants analysis, you can further extend your analyses, for example, you could
perform an outlier analysis to identify the cause of the error.

6.14.2.1 Variants in scaled systems

Each sub-server in a scaled system (sub-server and master-server scenario) calculates its
own process variants. If a sub-server is not connected to the master-server and a new
variant is calculated, the variant receives a sub-server specific name with the letter s.
Variants with the same name of the different sub-servers do not necessarily have to be
identical. For example, the variant s1 of sub-server 1does not have to be identical to variant s1
of sub-server 2.

The common master-server consolidates the various sub-server variants, provided the
sub-servers are connected to the master server. Variants that are consolidated in the
sub-servers are marked with the letter v. Variants with the same name and the letter v are
identical on all sub-server. Sub-server variants are automatically consolidated during the next
import cycle of a sub-server with a connected master.
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This chapter contains information on the general handling and basic functions of PPM.

Use default queries to start a predefined analysis and customize it in line with your
requirements.

Each analysis realm provides you with a specific, predefined analysis if it was created during
client customizing. When you open process analysis or a Data analytics analysis realm for the
first time, the default query is displayed immediately. When you open it again, the analysis you
last configured is displayed.
Procedure
1. Display the PPM start page.
2. Open the relevant analysis realm.

When you open the interaction analysis, click i Start.
The default query with the predefined settings is displayed in the analysis realm.

As in all other analyses, you can replace and set measures, dimensions, filters, etc., in the
default query.

You can display the predefined default query again any time.

PPM provides you with various options for adapting the user interface to meet your
requirements.

You can place individual bars and views at a particular position using drag and drop, combine
multiple bars, show or hide bars and adjust their size.

=  Move views (page 39)

= Swap views (page 39)

=  Adjust view size (page 39)

=  Move bars (page 40)

= Combine bars (page 40)

= Show and hide bars (page 40)
=  Adjust bar size (page 41)

= Show and hide tab bars

= Change tab order (page 41)
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When you exit an analysis realm your bar position settings will be saved.

You can restore the original bar positions (page 41).

7.21 Move views

You can move individual views in a multi-panel analysis using drag and drop.

Procedure

1. Create a multi-panel analysis.

2. Clickin the header of a view.

3. Hold down the mouse button and move the view to the relevant position using drag and
drop.
A frame with the label Insert view is displayed where the bar will be positioned.

The view is moved to the selected position.

7.2.2 Swap views

You can swap the position of individual views in a multi-panel analysis using drag and drop.

Procedure
1. Create a multi-panel analysis.
2. Clickinthe header of a view.

3. Hold down the mouse button and use drag and drop to move the view to the center of a
view whose position you want to swap.

A frame with the label Swap view is displayed.

The positions of the two views are swapped.

71.2.3 Adjust view size

You can adjust the width and height of the individual views in a multi-panel analysis.
Procedure
1. Create a multi-panel analysis.

2. Move the mouse pointer on the separating line of a view.

3. Move the separating line in the relevant direction while holding down the mouse button.

The size of the view is automatically adjusted.
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7.2.4 Move bars

You can move individual bars using drag and drop.

Procedure
1. Click in the header of a bar.

2. Hold down the mouse button and move the bar to the desired position using drag and
drop.

A frame is displayed at the location in which the bar will be positioned.

The bar is moved to the selected position.

7.2.5 Combine bars

You can combine multiple bars into one single bar. The bars are displayed as individual tabs in
the new bar.

Procedure

1. Click in the header of a bar.

2. Hold down the mouse button and use drag and drop to move the bar to the desired area
or bar you want to combine it with.

A frame is displayed around the selected bar.
The two bars are displayed as individual tabs in the new bar.
Click the title of a tab to display the bar.

7.2.6 Show and hide bars
You can hide bars that are not required for your current analysis and show them again later.
Thus, you create more space for displaying the analysis area.

Procedure

HIDE BARS
1. Display the View tab bar.

2. Click the button with the name of the bar you want to hide, for example, the Favorites

(*) bar.

The selected bar is hidden.

Alternatively, you canclick ¥ Close in a bar's title bar.
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SHOW BARS
1. Display the View tab bar.

2. Click the button with the name of the bar you want to show, for example, the Favorites

(*) bar.

The bar is displayed.

Tip

Use the bar at the right side of the work area to quickly show and hide bars.
Click the corresponding button in the bar, for example, Favorites (*).

Click ? Hide bars to hide all bars that are currently displayed.

7.2.7 Adjust bar size

You can adjust the width and height of the bars.

Procedure

1. Move the mouse pointer on the separating line of the bars.

2. Move the separating line in the relevant direction while holding down the mouse button.

The size of the bar is adjusted.

7.2.8 Change tab order

You can change the order of the tabs displayed in a bar.

Procedure
1. Click the tab header.
2. Usedrag and drop to move the tab to the position in which you want to place it.

The tab is moved to the selected position.

7.2.9 Restore bar positions

You can restore the original positions of the various bars.

Procedure

1. Display the View tab bar.

2. Click the Reset bar positions button.
3. Click Reset.

PPM closes automatically.
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4. Restart PPM to restore the original bar positions.

After restarting PPM, the bars will be displayed at their original positions.

1.3 Quickly find entries in lists and tree structures

You can use the keyboard to quickly find entries in various bars, certain dialog boxes, and
tables.
Procedure

1. Click the first entry in the interface element that you want to search, for example, the
first row in a table.

2. Then enter the first few letters of the word you want to find.

The selection will jump to the first position that begins with the letter combination you
entered.

In some interface elements, such as the Dimensions and Measures bars, you can use custom
search boxes to browse the list displayed.
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The information provided describes the settings and features as they were at the time of
publishing. Since documentation and software are subject to different production cycles, the
description of settings and features may differ from actual settings and features. Information
about discrepancies is provided in the Release Notes that accompany the product. Please
read the Release Notes and take the information into account when installing, setting up, and
using the product.

If you want to install technical and/or business system functions without using the
consulting services provided by Software AG, you require extensive knowledge of the system
to beinstalled, its intended purpose, the target systems, and their various dependencies. Due
to the number of platforms and interdependent hardware and software configurations, we
can describe only specific installations. It is not possible to document all settings and
dependencies.

When you combine various technologies, please observe the manufacturers' instructions,
particularly announcements concerning releases on their Internet pages. We cannot
guarantee proper functioning and installation of approved third-party systems and do not
support them. Always follow the instructions provided in the installation manuals of the
relevant manufacturers. If you experience difficulties, please contact the relevant
manufacturer.

If you need help installing third-party systems, contact your local Software AG sales
organization. Please note that this type of manufacturer-specific or customer-specific
customization is not covered by the standard Software AG software maintenance agreement
and can be performed only on special request and agreement.

If you have any questions on specific installations that you cannot perform yourself, contact
your local Software AG sales organization
(https://www.softwareag.com/corporate/company/global/offices/default.ntml). To get
detailed information and support, use our websites.

If you have a valid support contract, you can contact Global Support ARIS at: +800
ARISHELP. If this number is not supported by your telephone provider, please refer to our
Global Support Contact Directory.
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Find information, expert articles, issue resolution, videos, and communication with other ARIS
users. If you do not yet have an account, register at ARIS Community.

You can find documentation on the Software AG Documentation website
(https://empower.softwareag.com/). The site requires credentials for Software AG's Product
Support site Empower. If you do not yet have an account for Empower, send an e-mail to
empower@softwareag.com with your name, company, and company e-mail address and
request an account.

If you have no account, you can use numerous links on the TECHcommunity website. For any
questions, you can find a local or toll-free number for your country in our Global Support
Contact Directory and give us a call.

On the TECHcommunity website, you can find documentation and other technical
information:

= Usethe online discussion forums, moderated by Software AG professionals, to ask
guestions, discuss best practices, and learn how other customers are using Software AG
technology.

=  Access articles, code samples, demos, and tutorials.
=  Find links to external websites that discuss open standards and web technology.

=  Access product documentation, if you have TECHcommunity credentials. If you do not,
you will need to register and specify Documentation as an area of interest.

If you have an account for Empower, use the following sites to find detailed information or
get support:

=  Youcan find product information on the Software AG Empower Product Support website.

= To getinformation about fixes and to read early warnings, technical papers, and
knowledge base articles, go to the Knowledge Center.

= Once you have an account, you can open Support Incidents online via the eService
section of Empower.

= To submit feature/enhancement requests, get information about product availability, and
download products, go to Products.
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SOFTWARE AG MANAGED LEARNINGS

Get more information and trainings to learn from your laptop computer, tablet or smartphone.
Get the knowledge you need to succeed and make each and every project a success with
expert training from Software AG.

If you do not have an account, register as a customer or as a partner.
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